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MotionWatch Regulatory Information 
 

Medical Device Directive (European Union) 
 
The MotionWatch is a Class I Medical Device conforming to the 
essential safety & health requirements and provisions of EC Council 
Directives 93/42/EEC, Annex VII. An EC declaration of Conformity will 
be provided upon request. 
 

Manufacturer 
  

CamNtech Ltd 
Manor Farm 
Fenstanton 
Cambridgeshire 
PE28 9JD, UK 

 
Tel:  01480 831223 
Fax: 01480 831733 
Email:  technical@camntech.co.uk 
Web:   www.camntech.co.uk 
 

 

US FDA status 
 

 
Australian TGA 

 
Emergo Australia 
Level 20 
Tower II, Darling Park 
201 Sussex Street 
Sydney, NSW 2000 
Australia 

 

 

mailto:technical@camntech.co.uk
http://www.camntech.co.uk/
mailto:inquiry@camntech.com
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IMPORTANT SAFETY INFORMATION  
WARNINGS 

 Coin cell battery – potential swallowing hazard for small 
children! 

 Not Defibrillation proof. 

 Not indicated for use on areas of broken, damaged or irritated 
skin. 

 Devices removed from subjects must be considered to be 
contaminated – see APPENDIX C. 

Safety Classification Information: 

 MotionWatch is INTERNALLY POWERED EQUIPMENT. 

 MotionWatch mode of operation is CONTINUOUS OPERATION. 

 MotionWatch is for PRESCRIPTION USE ONLY (Rx Only) - USA. 

Device and Packaging Symbols and Markings: 

 

MEANING SYMBOL DESCRIPTION 

General Warning 
 

Potential hazard - refer to the warnings in 
the instructions for use (i.e. this user 
guide). 

Consult Instructions 
for Use 

 
This symbol indicates that important 
operational information is contained in the 
user instructions (i.e. this user guide). 

Ingress Protection 
Rating 

IPX7 
The MotionWatch is suitable for temporary 
immersion in water (up to 1 hour at 1m). 

Serial Number 
 

This number provides a unique 
identification for a particular device. Always 
quote this number when seeking technical 
assistance. 

Catalogue Number 
 

This number identifies this particular variant 
of the product range. 

Manufacturer and Date 
of Manufacture 

 
This symbol is accompanied by a date in 
the format yyyy-mm which indicates when 
the device was manufactured. The symbol 
is also accompanied by the address and 
contact details of the manufacturer 

Electrical Safety 
Classification 

 
The MotionWatch is a TYPE B APPLIED 
PART. 

 

 
 

FOR FURTHER HANDLING & ENVIRONMENTAL INFORMATION PLEASE 
REFER TO APPENDIX C 
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IMPORTANT BATTERY ADVICE 
 

Battery Replacement 
 
The MotionWatch operates at very low power. When the battery is removed, the 
watch requires some time to fully reset. 
 

It is essential that the battery replacement process is observed 
fully to ensure that any new battery is correctly registered in the 
watch. 
 
Do not fit a new battery without observing the correct 
procedure as detailed in Appendix A4. 
 
Always use a new, retail packaged battery – never re-use a part 
used battery. 
 

Always choose a quality branded battery – budget brand batteries have much lower 
energy and can significantly reduce performance. CamNtech recommends the 
battery is removed if the device is not used for a period of more than 30 days, in 
order to prevent potential damage from battery leakage. Observe the storage 
information below for the removed battery. 
 
Failure to observe the correct procedure may result in loss of data. 
 

Battery Storage 
 
The MotionWatch uses a CR2032 coin cell battery: 
 

 
 
NEVER Store loose batteries together – they will short and 
may generate heat. 
 
Shorted batteries can no longer be used and should NOT 
be fitted to the MotionWatch. 
 
Poor storage may result in loss of data. 

 
 

Choking/Swallowing 
Hazard 
 

 
 
 
 
 
 
 

 
 

NEVER allow young children to have access to an open 
MotionWatch as the battery may be a choking or 
swallowing hazard. 
 
In normal use the watch closure should be sufficient to 
prevent a child opening and accessing the battery. 
 
If the case lid becomes loose, do not use the watch with 
young children and seek assistance from CamNtech. 
 

! 
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Main Window Overview 
 
 
The following image identifies the main components referenced in this document. 
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1 Introduction to the MotionWatch for PLMS 
System 

 
 

1.1 An Overview of 
the MotionWatch 
for PLMS System 

The MotionWatch is a compact, lightweight, body-worn 
activity monitoring device that is used to document 
physical movement associated with applications in 
physiological monitoring. The device is built to monitor limb 
or body movements during daily living and sleep. The 
MotionWatch can be used to assess Periodic Limb 
Movement during Sleep using the PLMS Analysis software 
package. This allows for the set-up, download and analysis 
of data captured with the MotionWatch.  
 
The MotionWatch itself also allows a variety of other 
physiological monitoring functions using other software – 
contact Camntech for further information. 
. 

 
Components Required for a System 

A MotionWatch for PLMS system consists of 2 elements:  
 

 One or more MotionWatch devices. 

 PC based PLMS Software providing set-up, download 
and analysis functions. 

 
Note that no reader or interface is required – the 
MotionWatch has a direct USB connection. 

 

1.2 The MotionWatch 8 
 

 
 
  

 
 
 

 

 

 

 

 

 

 

 

Event Marker: The MotionWatch 8 has a front-panel button 
that may be pressed by the subject to mark specific 
events. Typically this will be used to mark when the subject 

Light sensor 

Status Indicator 

Event Marker Button 
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goes to bed and when the subject gets up in the morning. 
The use of the marker will insert a date/time stamped mark 
within the data. 
Light Sensor: The MotionWatch 8 has a front-panel 
ambient light sensor which can optionally be enabled to 
collect indoor or outdoor light exposure. This function is 
also useful to observe the ‘lights out’ period during sleep. 
Status Indicator: Provides visual feedback by flashing 
when the event marker is pressed. Also used to indicate 
USB connection and during the battery replacement 
process. 
 

Opening the MotionWatch Casing 

The MotionWatch utilises a novel ‘twist-lock’ casing which 
provides a waterproof seal for the electronics and USB 
connection while facilitating easy access to the battery. 
To open the casing, grasp the front of the watch by the two 
finger grips and rotate anti-clockwise by approximately 
15 degrees to release. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
WARNING!  
DO NOT ATTEMPT TO FORCE OPEN/CLOSED THE 
MOTIONWATCH CASING WITHOUT TWISTING TO 
UNLOCK/LOCK. DOING SO WILL DAMAGE THE 
CASING AND INVALIDATE THE WARRANTY! 
 
Now gently lift out the front section of the casing… 
 
 
 
 
 
 
 
 
 
 
 
 
 
Then turn over to access the USB connection… 
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When the MotionWatch is connected for the first time, the 
USB drivers will automatically be installed (see Section 2.5 
Installing the USB Drivers). 
 

Closing the MotionWatch Casing 

The casing must be closed with the parts correctly aligned. 
To aid with alignment, coloured indicators have been 
provided as shown in the figure below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With the indicators aligned, drop the top part of the casing 
into the lower part and then turn clockwise by 
approximately 15 degrees to close. 
 
WARNING!  
DO NOT ATTEMPT TO FORCE OPEN/CLOSED THE 
MOTIONWATCH CASING WITHOUT TWISTING TO 
UNLOCK/LOCK. DOING SO WILL DAMAGE THE 
CASING AND INVALIDATE THE WARRANTY! 
 

1.3 Body Mounting 
Position 

The MotionWatch should be mounted as far up the foot, 
and as close to the big toe as possible in order to 
maximise sensitivity for detecting PLM activity. 

USB Connection 

Alignment Indicators 
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1.4 The PLMS 
Software 

The software has been designed to analyse Periodic Leg 
Movements in Sleep (PLMS). Real world usage of this 
software includes the identification of Periodic Leg 
Movement Disorder (PLMD) in a person by analysing the 
movements which occur during sleep. This includes 
measuring the regularity and severity of the disorder. 
  
The software is designed to use data recorded by 
MotionWatch 8 devices and you can therefore manage 
these devices directly from within the software.  

 
A brief breakdown of the process is as follows: 
 

 Set a MotionWatch for each limb to record 
movement activity 

 Record data for a series of nights (or sleep periods) 

 Download the data from each MotionWatch 

 Load the data files into the PLMS Analysis software 

 Set up the analysis by specifying start/end dates 
and times 

 *Merge the independent data channels for each 
limb into a new channel 

 *Assess the automatic identification of PLM 
assigned by the software and add or remove PLM 
where applicable 

 *Create on-screen messages to highlight important 
areas 

 Review scores and results 

 *Print the analysis results to produce physical 
report 

 *Export raw data to use in external applications 

 *Save the analysis for future use 
 
*Optional 
 
 

1.5 Intended Use 
The MotionWatch is a compact, lightweight, body-worn 
activity monitoring device that may be used to document 
physical movement associated with applications in 
physiological monitoring. The device is intended to monitor 
limb or body movements during daily living and sleep. The 
MotionWatch can be used to assess activity in any 
instance where quantifiable analysis of physical motion is 
desired.  
NOTE: the device software should not be used directly 
for diagnostic or therapeutic decision making. 

1.6 Contraindications 
The MotionWatch is indicated for use on healthy, 
undamaged areas of skin. Where the patient has a history 
of skin irritation, a device should be worn for a brief period 
to test for skin irritation prior to commencing any recording. 



PLMS Software User Guide: Issue 1.0.23  Page 13 
 

Any device in close contact with the skin can trap sweat or 
moisture and cause redness or slight skin irritation. If this 
occurs, remove the watch and do not wear it for 2-3 days 
to allow the irritation to clear. 
 

1.7 Patient 
Population 

There are no restrictions on the intended patient 
population for the MotionWatch devices. 
 

1.8 Required Skills, 
Training & 
Knowledge of 
Intended Users 

It is intended that the device be administered only by duly 
qualified health care professionals, researchers and or 
trained nursing staff, possibly in a hospital environment. 
 

1.9 General 
Description of 
Use 

The MotionWatch contains a miniature accelerometer to 
allow measurement and recording of physical movement of 
the wrist which provides a close correlation to whole body 
movement. The data are sampled at 50Hz and 
summarised every second for PLM analysis. These data 
are stored into an internal non-volatile memory and then 
downloaded for analysis at the end of the study period. 
 
Data recorded by the MotionWatch may be downloaded 
and analysed off-line using the PLMS or MotionWare 
Software Package.  

1.10 Inspection 
Before Use 

The MotionWatch (including strap) shall be inspected for 
signs of damage or wear before each use. Do not use the 
device if the inspection reveals any damage. 
 
Contact CamNtech UK or your local representative if you 
suspect your MotionWatch device(s) may have sustained 
damage. 
 

1.11 Service Life 
The recommended service life of the MotionWatch devices 
is 5 (five) years. 
 

1.12 Modifications 
DO NOT ATTEMPT TO MODIFY THE MOTIONWATCH 
IN ANY WAY. Doing so may affect device safety and/or 
performance, and will nullify any remaining device 
warranty. 
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1.13 Adverse 
(Serious) 
Events 

Any and all serious/adverse events which result in patient 
harm MUST be reported to CamNtech and your national 
Competent Authority. Refer to guidance provided by your 
local legal authority for information on reporting procedures 
and timescales. 
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2 Installing the PLMS Analysis Software 
 
 

2.1 System 
Requirements  

The PLMS software is provided via download (A USB stick 
can optionally be provided at extra cost). The installer 
contains all of the components required to install the 
software package. The following are the minimum 
requirements of a host PC for installing the PLMS 
software:  

 Windows® 8 or 10, 32 or 64bit operating systems. 

 IBM compatible 2GHz + processor speed 
recommended 

 500 MB hard disk space 

 One free USB port 

 SVGA graphics card (1280 x 1024) recommended. 

 
CamNtech recommends the following minimum security 
requirements for the host PC: 

 Use of strong user login passwords 

 Enabling of automatic Windows updates 

 If the host PC is networked, use of Windows 
Firewall (or third-part alternative) – ensuring 
updates applied 

 Use of Windows Defender anti-malware (or 
third-party alternative) with automatic 
definitions updates enabled. 

 
CamNtech recommends that the MotionWatch is not 
connected to any PC other than a dedicated host PC 
which meets the above requirements and is running the 
PLMS software. 

2.2 Software Registration 

To access the PLMS software download, it is necessary to 
first register the software with CamNtech. Please visit 
www.camntech.com/register to register your software 
using the reference number provided with your equipment. 
You will then be provided with a username and password 
allowing log-in and download of the software at any time 
during the two year warranty period. 
Note that CamNtech standard software licensing allows up 
to 3 users to register and use one copy of the software. 
You will also be provided with a software serial number 
that will be required to activate the software following 
installation (see section 2.6 below) 
The software will continue to be fully functional beyond the 
warranty period but updates will no longer be provided. 
 

 

http://www.camntech.com/register
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2.3 Installing the 
Software 

Download the installer (.msi) from the CamNtech website: 
www.camntech.com/downloads  
Double click on the downloaded .msi file to run the installer 
then follow the installation process. 
A message warning that ‘Publisher cannot be verified’ may 
be displayed – click ‘Run’ to accept (this is a Windows 
security warning and is not a problem). 
Note that the software requires the Microsoft .NET 
Framework 4 to operate – this will be automatically 
installed if not present. 
 

 

2.4 Updating the 
Software 

If you are updating or reinstalling the software you should 
first remove the old version. The installation has to then be 
restarted by double-clicking on the installation file as 
described in section 2.3 above. Note that any data and 
settings are not lost during re-installation. 

 

2.5 Installing the 
USB Drivers 

This section on installing drivers only applies to new 
installations. 

 

 The MotionWatch utilises generic Windows USB 
drivers which are provided as part of the Windows 
operating system. 

 To install the drivers, attach the supplied USB cable to 
a free USB port and connect to the MotionWatch. 

 Depending upon the version of Windows, a sequence 
of messages similar to that shown below will be displayed 
at the bottom of the screen: 

 
 
 
 
 
 

 
If prompted, you may be required to restart the PC. 
 
The driver installation is now complete. 
 

2.6 Software Serial 
Number 

There is a 30 day evaluation period included with the 
software. After this time, a valid serial number will need to 
be applied. To apply a serial number, click on the ‘Help’ 
menu and click the ‘Serial Number’ menu item. Enter your 
8-digit serial number into the serial textbox and click the 
‘Apply’ button. 

http://www.camntech.com/downloads
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If you do not already have a serial number you will need to 
register the software. To do this, click the ‘Help’ menu, 
and click the ‘Serial Number’ menu item to load the serial 
dialogue box. Click the ‘Register’ button to open a link to 
the CamNtech website (note: you will need the reference 
number supplied with the software). Fill out the registration 
form and click the ‘Submit’ button to complete the 
registration. Your serial number will be delivered via email. 
 
When you have received your serial number, enter the 
serial number into the serial textbox and then click the 
‘Apply’ button. 

 

2.7 Running the 
Software 

Double clicking on the PLMS Analysis icon on the desktop 
will start the software. If a MotionWatch is connected it will 
be automatically detected and the MotionWatch Manager 
screen will be displayed. The front screen of the software 
with no MotionWatch connected will be similar to that 
shown below: 
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2.8 Software 
Settings 

The operation of the PLMS Analysis software is affected 
by a number of global settings. These can be changed 
through the main window from the ‘Tools’ menu and then 
‘Settings’ menu item. 
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Institution Name 

Your institution name can be entered here. It will be used 
on printed reports, so that feedback to patients or 
volunteers can be linked with the organisation name. 
 

Automatically Check for Updates 

When this setting is checked, the application will check for 
a new version once per day. 

 
Show Tutorial 

Setting this option will show the tutorial help window every 
time the software is started. This is enabled by default to 
help you learn to use the software. 
 

Show Legend 

Setting this option will show the colour legend every time 
the software is started. This legend helps explain the 
different meaning of colours used in the PLM display, to 
assist in reading it and manually adjusting it. 
 

Insert Default Times 

When new recordings are loaded into the software, it is 
necessary to specify the sleep time periods before 
analysis. Selecting this option will auto-fill default times to 
speed up that process, but may not correctly fit all 
requirements. 
 

Automatically Link 

When two or more channels are loaded, they can be linked 
so that scrolling one graph will scroll the other to keep the 
scroll positions synchronised. Setting this option will cause 
this linking to happen automatically when recordings are 
set up, rather than manually through the Tools menu. 
 

Automatically Merge 

Once a recording from a left limb and a right limb are 
loaded, it is possible to create a merged recording using 
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the ‘Analysis’ menu. Setting this option will instead 
automatically create the merged recording whenever two 
limb recordings are opened together. 
 

Automatically Score 

This setting determines whether or not the software will 
perform automatic PLM analysis and marking for a newly 
loaded recording. 
 

Show PLM Duration and Periodicity 

Enabling this setting will show the duration of PLM bouts, 
and periodicity between bouts on a channel’s actogram. 
The duration will be marked in red and the periodicity will 
be marked in blue. The values are shown in second. 
 

Combine Kicks 

This setting controls how the automatic PLM analysis 
treats very close together movements with a short gap. 
The standard definition of PLM for diagnosis does not 
mention these but instead relies on sensible human 
interpretation of what a single movement is. We 
recommend a setting of ≤ 2 seconds. 
 
Click ‘OK’ to save the new settings. Click the close [x] icon 
at the top right to close the window without saving the 
settings. 

Set Algorithm for 

Allows you to switch between settings for abiding to 
ICSDv2 (2005) or AASM 2.1 (2014) specifications for 
handling PLM kicks. Selecting the ‘Custom’ option will 
allow you to override these settings. 
 

Maximum Movement Length 

This setting allows you to override the maximum allowable 
length for classifiable PLM movements. The default of 10 
is recommended as it abides to the current ICSDv3 in 
relation to PLM movement diagnostics. 
 

Apply a Threshold 

This setting controls how high sensitivity noise is filtered 
for recording. This is useful as the MotionWatches record 
in a high sensitivity mode to obtain the most accurate level 
of movement for PLM activity. As a result, recording can 
pick up low level noise which can mask genuine PLM 
activity. A threshold of 5 is recommended as it provides the 
best amount of filtering suitable for detecting PLM 
movements. 

 
Check for Updates 

Clicking this link will perform a manual check for updates 
to the application. 
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3 The MotionWatch Manager 
 
3.1 MotionWatch 

Current Set-up 
With the PLMS Analysis Software already started, connect 
a micro-USB cable to the MotionWatch; the watch will 
automatically be detected and the ‘MotionWatch Manager’ 
screen will be displayed as shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If a MotionWatch is connected but the above screen is not 
shown, click on the ‘Tools’ menu and ‘MotionWatch’ item 
in the main window. 
 
The MotionWatch Manager screen is automatically closed 
when the MotionWatch is disconnected. 
 
The MotionWatch setup options will be explained in detail 
in the following section. 

  

Setup Watch: click to start a new 
MotionWatch setup (Section 3.2) 

Read Data: click to download the data from 
the MotionWatch (Section 4.1) 

Details of the current set-up stored in the 
MotionWatch. 

Click to view/edit advanced functions 
(Appendix A) 

CURRENT SETUP INFORMATION 

3 MAIN OPTIONS: 

UTILITIES TAB 
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3.2 Applying a 
New Set-up 

Click the ‘Setup Watch’ button, the ‘New Setup’ tab is 
activated and the settings may now be edited: 
 

  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Immediate or Delayed Start 

Select ‘Immediate Start’ to ensure that the MotionWatch 
begins recording straight away. The start date and time are 
taken from the PC clock so please ensure that this is 
correct. A delay of up to 2 minutes is added to the current 
time and the recording will start on a complete minute. If 
for example the set-up is applied at 16:46:27, the delay will 
be one minute and 33 seconds and the recording will begin 
at 16:48:00. 
 
Select ‘Delayed Start’ to show the start date/time controls. 
This option allows the recording to be delayed for up to 30 
days into the future. Use the date, hours and minutes 
controls to select the required start date and time. 
 

NOTE: Applying a new set-up to the MotionWatch will 
result in the loss of any existing stored data or set-up 
information – please ensure that any required data has 
been downloaded first. Click the ‘Cancel Setup’ button 
to return to the current setup tab without applying the 
new setup. 
 

User ID: Enter characters to identify the 

subject/patient/study. 

Full Name: [optional] Enter characters to 

identify the patient/study. Note that the 
maximum length is 64 characters shared 
between user ID and Full Name. 

Gender: Use the dropdown to select M, F 

or X (if gender is to be undisclosed). 

Date of Birth: Use the date control to enter 

the date of birth of the subject. 

Start Date & Time: Select delayed start to 

begin a recording up to 30 days in the 
future. Immediate start will begin in 1-2 
minutes after disconnection. 

Recording Mode: The recording mode 

should be left in the preset choice for PLM 
detection. 

Limb Type: Use the drop down control to 

select the left or right limb. 

Epoch: An epoch of 1 second is used for 

PLM detection.  Other epochs are only 
used for alternative uses with the 
MotionWare software. 

Battery Life: Indication of approximate 

battery life remaining in % and colour 
coded battery gauge. Hover over with the  
mouse for more information. 

Recording Length: Shows the expected 

maximum length of the recording based 
upon the chosen settings. 
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Recording Mode 

The MotionWatch offers several recording modes for other 
applications, but only the pre-selected high sensitivity 
mode should be used for PLM detection.  

Body Position 

For PLMS, select ‘Left limb’ or ‘Right Limb’ to ensure the 
monitored limb is identified in the analysis.  

 
Epoch 

The epoch is the duration for which the MotionWatch will 
accumulate samples before storing the result in memory. 
The MotionWatch offers a range of epochs for other 
purposes, but only the one second epoch is suitable for 
PLM detection. 

 
Recording Length 

The MotionWatch displays the expected maximum 
recording length, assuming the battery has sufficient 
capacity to fill the recording memory. 
 

Battery Life Gauge 

The MotionWatch Manager screen shows the battery life 
gauge to provide an indication of remaining battery life 
using a colour coded bar. The bar will change colour to 
provide a clear indication of battery status as the battery 
becomes depleted. The battery life gauge has the following 
indications: 
 
Green – 60% to 100% (72 to 120 days approx.) 

 
 
Yellow – 40% to 59% (48 to 71 days approx.) 

 
 
Orange – 20% to 39% (24 to 47 days approx.) 

 
 
Red – 0% to 19% (0 to 24 days approx.) 

 
 
When the battery life falls below 15%, the gauge will flash 
and an additional message will be displayed in the status 
area (as shown above).  
If set-up is attempted with a short battery life, an additional 
warning message will be displayed. 
 
ALWAYS REPLACE THE BATTERY IF THE RECORDING 
IS LONGER THAN THE ANTICIPATED BATTERY LIFE. 
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Battery Life 

The MotionWatch uses a standard non-rechargeable 
CR2032 coin cell which is easily replaced by the user (see 
Appendix A4). The MotionWatch incorporates smart 
battery monitoring to measure actual device usage and 
battery voltage to calculate an expected life remaining. The 
maximum expected battery life will be 4 months 
(MotionWatch Mode) and the battery life indication will 
provide a percentage of life remaining. Hovering over the 
battery life in either the current or new setup screens will 
show the expected battery life in days in the information 
pane of the MotionWatch Manager. 
The MotionWatch monitors several parameters to 
automatically detect when a new battery is fitted. 
The watch will shut down when the battery is depleted – 
light recording will cease before activity recording. 
Other factors such as operating temperature can 
significantly reduce the battery life. 
The MotionWatch requires some time to shut down fully 
and restart when the battery is replaced. Always follow the 
steps for battery replacement in Appendix A4. The correct 
battery replacement process is CRITICAL and data 
may be lost if not completed correctly. 

 
Compress Data 

It is possible to compress the activity data to allow longer 
recordings at shorter epochs. The function uses a 
logarithmic compression which provides lower accuracy at 
higher values (quantized data). At low levels, the accuracy 
is not affected at all. This option is enabled for PLM 
recording. It allows longer recording at the 1 second 
epoch, but means that some quantization will occur at 
higher movement values during the day. So caution should 
be used if the daytime movement data during a PLM 
recording is to be compared to other daytime recordings 
set up using the MotionWare software.  

Disable Marker Button 

Select to disable the marker button. 
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4 Downloading Data 
 

4.1 MotionWatch 
Download  

From the MotionWatch Manager Window click on the 
‘Read Data’ button. The download will begin and the 
progress notification will be displayed… 
 
 

 
 

 
 
 
 

If the data download is not required, click the ‘Cancel’ 
button and the operation will be aborted. 
 
When the all data has downloaded (full memory will take 
less than 1 minute) the ‘Save Recording…’ dialog will open 
to allow the data to be saved. 
 
 
Note that the recorded data in the MotionWatch is not 
erased after download; It is only erased when the watch is 
set up again. 
 

4.2 Saving 
MotionWatch 
Data  

Upon completion of the download, the ‘Save Recording…’ 
dialog will open automatically to allow the data to be 
saved. 
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This window allows the save file to be specified for the 
downloaded recording. Type the name of the file as 
required and click the ‘Save’ button. The file will be saved 
in the default *.mtn format. If you do not wish to save the 
file, click the ‘Cancel’ button to return to the MotionWatch 
Manager. 
 
Note that the MotionWatch Manager will not automatically 
close when the MotionWatch is disconnected if data has 
been downloaded and not saved. This serves as a 
reminder to save the data; you may manually close the 
window if the data is not required. 
 

4.3 Shutdown after 
Download  

The PLMS Analysis software defaults to shut-down the 
MotionWatch into sleep mode to save battery power 
following download. Data will NOT BE LOST but the watch 
will cease recording.  
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5 Preparing to Analyse Data 
 

5.1 The PLM Analysis 
Window 

The PLM analysis window is the centre for displaying and 
analysing PLM data. When initially opened, the menus for 
opening data files and changing settings are available. The 
main display is shown when one or more recordings have 
been loaded for analysis, or if a saved analysis (.pax) file 
has been opened.  
 

5.2 Loading 
Recordings 

The application comes with two demonstration files which 
are installed by default. These can be found in the 
following directory (replace [Username] with your 
username): 
 
C:\Users\[ Username]\Documents\PLMS Analysis Data 
 
After downloading data, you must choose which recordings 
to open for analysis. This may be one or more left or right 
limb recordings, loaded alongside one another. To load 
your recordings, follow the procedure below: 

 
1) When the application has loaded, click on the 'File' 

menu, and then click on the 'Open Data' menu item. 
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2) From the Setup Analysis window, click on the 
'Browse' button for Channel 1 located in the top right 
corner of the window. 

 

 
 
3) The application may automatically try to guess the 

correct amount of sleep periods and dates/times for 
the recording, depending on the current setting. 
Default values will be applied if it cannot determine 
them. 

4) If applicable, select the correct limb type from the drop 
down box.  
 

 
 
5) Enter the correct number of sleep periods contained 

within the recording from the drop down box. 
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6) If your test includes a Suggested Immobilisation Test 
(SIT), or your test is for PLM in Wakefulness (PLMW), 
then click the Suggested Immobilisation Test 
checkbox. 
 

 
 

7) Enter the correct start and end date/times for each 
day in the recording. Dates can be changed by 
clicking the left mouse button on the individual date 
element (e.g. dd/mm/yyyy). Times can be changed by 
typing in the hours and minutes in the time fields. The 
time ranges will be highlighted as a red rectangle in 
the recording overview at the bottom of the window. 
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You can quickly switch between time fields by 
pressing the tab key on the keyboard. 
 

8) Confirm that all fields are correct and left-click the 
'Load' button. 
 

 
 

9) You load two limb recordings simultaneously by 
clicking on the 'Browse' button for both channel 1 and 
then channel 2. The start and end dates/times will be 
applied to both channels and both will be loaded. 

 

5.3 The Movement 
Display 

For each recording channel, a graph similar to that shown 
below will be displayed. This shows a single period of 
movements. Two graphs can be loaded in one analysis 
session, and an optional third merged channel can also be 
created. 
 
The large upper graph shows a zoomed-in period of the 
recording - in this instance showing 5 minutes of the 
movement period starting at 00:45:28 and ending at 
00:48:11. Each vertical black block represents the amount 
of movement during a single second of the recording. Solid 
blocks of black are produced by consecutive seconds of 
movement. 
 
The shorter lower graph shows the movement over the 
entire movement period. It is not as clear as the zoomed 
graph, but displays an overview of the entire night. It is 
overlaid with a red rectangle illustrating the current location 
of the zoomed-in period. 
 

 
 
A legend explaining the meaning of the various colours on 
the graph can be shown (if not already open) by clicking 
the ‘Help’ menu and then the ‘Colour Legend’ menu item. 
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5.4 Switching Days 

When recordings are broken down into multiple days, each 
day will be listed in the Period drop down for that 
recording. Periods (Sleep or Wake) can be switched at any 
time by clicking on the relevant item from the drop down 
menu. 
 

 
 
 
If the channels are linked, then all other channels 
(including merged channels) will change to the day 
specified. 
 

5.5 Scrolling 
Graphs 

The application is designed so that the user sees a window 
of data (default 5 minutes) at any given time. This provides 
an efficient way to browse through large sleep periods. 
Scrolling through the data can be achieved in the following 
ways: 
 

1) By clicking on the previous/next buttons on each 
panel to scroll in fixed values (default 5 minutes). 

2)  
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3) By dragging the red preview rectangle with the mouse 
(hold left click) to scroll freely. 

 

 
 
4) By pressing the left and right keys on the keyboard to 

scroll freely. 
 

 
 
 

5.6 Changing the 
Graph Scale 

Data shown on the graphs can become difficult to view, 
especially with a large variation between maximum and 
minimum data values. To address this, the magnitude for 
each data channel can be changed to increase low values 
or decrease high values.  
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The factor of magnitude for data values is increased or 
decreased by clicking on the arrows at the left side of a 
channel’s activity graph.  
 

 

 

5.7 Merging 
Channels 

Multiple channels can be merged into a separate channel 
in order to create a unified view of a recording when more 
than one limb is monitored.  
 
With two channels loaded, click on the 'Analysis' menu, 
and click on the 'Merge Channels' menu item. The 
application will automatically combine the data from both 
channels by comparing the data samples for each second 
and obtaining the value with the higher magnitude value. 
The application will then analyse this new channel to 
identify PLM bouts and will produce a new set of results. A 
new graph will appear at the bottom of the window to view 
the combined data. 
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5.8 Linking Graphs 

To synchronise channel scrolling, click on the 'Tools' 
menu, and click on the 'Link Channels' menu item.  
 

 
 

To desynchronise channel scrolling, click on the 'Tools' 
menu, and click on the 'Unlink Channels' option. 
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6 Analysing for PLM during Sleep 
 

6.1 Automatic 
Analysis 

The software will automatically analyse all recordings 
loaded, attempting to mark relevant sequences of limb 
movements in line with the common definitions for periodic 
limb movement. 
 
The window below shows how this is illustrated when a 
short sequence of six movements has been marked as a 
PLM bout. 
 

 
 

In this example, the bout is shown by the central shaded 
green region. It contains six movements, each of which are 
also highlighted by the short red burst at the top of the 
green shading. The movements before the bout were not 
marked as part of the bout as they were considered to be 
too continuous. The gap after the end of the bout was not 
marked as it was too large to be classified as PLM. A 
previous, not related, bout is also shown on the left of the 
displayed period. 
 

Automatic Analysis Rules 

Automatic analysis is carried out for movements which 
satisfy the criteria for diagnosis of Periodic Limb Movement 
Disorder in the International Classification of Sleep 
Disorders Diagnostic and Coding Manual, 3rd Edition 
(2014).  These are applied to the movement data by the 
software, but results must then be considered alongside 
other observations by a practitioner before any diagnosis 
can be made. 

 
In line with the ICSD Manual, but applied to actigraphy, 
parts of the recording are searched for which demonstrate 
repetitive, highly stereotyped, limb movements that are: 
 

a. 0.5 to 10 seconds in duration* 
b. In a sequence of 4 or more movements 
c. Separated by an interval of more than 5 

seconds (from limb-movement onset to limb-
movement onset) and less than 90 seconds 
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(typically there is an interval of 20 to 40 
seconds) 

 
*The ICSDv2 threshold (0.5 to 5 seconds) can be 
optionally set in the program settings 

 
Combining Kicks 

In addition to the PLM criteria above, movements which 
are separated by only a few seconds may be joined before 
consideration. A human performing analysis would 
normally make such an adjustment automatically where for 
example there are large gaps both before and after 
movements but a short movement on each limb separated 
by only a second. This setting may be changed in the 
software through the ‘Tools’ menu, then ‘Settings’ menu 
item and the ‘Combine kicks…’ setting. 
 

6.2 Manually 
Adjusting 
Movements / 
Bouts 

After automated analysis, all of the detailed classifications 
can be examined and if desired, manually adjusted to suit 
the opinion of the practitioner. All such adjustments will be 
taken into account in results statistics subsequently 
viewed. The example below illustrates how to make 
manual adjustments. 
 

 
 

In this data, the movement circled in purple has been 
excluded from the following PLM bout because it is 8 
seconds long, and thus doesn’t follow the ICSD criteria 
above. But it can be added manually if desired. First, you 
must check in the blue circle above and use the drop-down 
menu to ensure that [Mark as PLM] is the selected tool. 
Then, use the mouse to drag across the time period as 
shown in the next image. 
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After dragging the mouse across this with the [Mark as 
PLM] tool selected, the new marked classification will look 
as below, showing the extra movement added into the 
following bout. 
 

 
 

If subsequently you decide this was a mistake, return to 
the blue circle below and select the [Restore] function, 
before dragging across the pink arrowed period again. This 
will restore all of the original classification to that time 
period. 
 

 
 

Finally, it is also possible to manually remove movements 
which have been labelled as PLM. Returning to the original 
classification period, the last movement of the prior bout 
was both longer and later than previous movements, so we 
wish to remove it. This time follow the blue circle to select 
the [Mark as not PLM] tool. 
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After selecting, drag the mouse across the movement for 
removal, as shown by the pink arrow. This will cause the 
green background of the previous PLM bout to recede to 
cover only up to the prior movement. 
 

 
 

You can also restore the original classification here using 
the [Restore] tool as before. In addition to dragging across 
the movements, each of the tools can be used in a single-
click mode, where the effect will be isolated to the clicked 
item. 
 

6.3 High 
Sensitivity 
Data 

The software applies a high sensitivity setting when setting 
up a MotionWatch which provides greater accuracy for 
detecting PLM. This can introduce additional low-level 
noise, and so it is necessary to apply a filter to recording 
data to remove unwanted noise.  
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By default, the software will filter any samples below 5 
counts, and thus will be ignored by the data analysis 
function. The filtered samples will be drawn in orange as a 
reference.  
 
 
 

 
 
This setting can be overridden* either by disabling the 
function entirely, or by setting the filter count threshold. To 
change these settings, open the program settings by 
clicking on the ‘Tools’ menu, followed by the ‘Settings’ 
menu item. To disable the noise filter, click on the ‘Apply a 
threshold to channels to filter high sensitivity noise’ 
option/checkbox to disable the option. The noise threshold 
can be set by clicking on the dropdown box for 
‘Threshold: <=’.  
 

Filtered high-
sensitivity noise 
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* PLM markings may be reset 
 

 

6.4 Adding User 
Annotations 

The application allows annotations to be placed anywhere 
on a graph. These annotations are saved when the 
analysis is saved which allows them to be viewed by other 
users at a later date. 
 
To add an annotation, point the mouse cursor anywhere 
over a graph, then hold down the Ctrl key on the keyboard 
and click the left mouse button. In the dialog box which 
appears, enter any text remarks and press the 'OK' button 
to save the annotation. A notepad icon will be placed onto 
the graph where the mouse cursor was pointing.  
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To open a previously created annotation, point the mouse 
cursor over the notepad icon, hold down the Ctrl key on 
the keyboard and click the left mouse button. The 
annotation can be updated by making any changes to the 
text field and clicking the 'OK' button. 
 
To delete an annotation, point the mouse cursor over it, 
hold down the Ctrl key and click the left mouse button. 
Click on the 'Delete' button to remove it. The notepad icon 
will disappear.  
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7 Using Your Results 
 

7.1 Viewing 
Summarised 
Results 

The application automatically produces an on-screen 
summary report which contains scores, results and 
statistics for each day in a channel, across each channel in 
an analysis (including a merged channel). 
 
The summary can be viewed by clicking on the 'Tools' 
menu and clicking on the 'Show Results' menu item.  
 

 
 
The summary for the first available channel and day will be 
shown automatically. Each channel can be selected by 
selecting the appropriate entry in the drop-down box 
located at the top-left of the summary window.  
 
Periods (Sleep/Wake) can then be selected from the list 
below the channel select drop down. 
 

v 
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The results summary window allows users to enter custom 
text into the text box at the bottom of the form. Any text 
which is entered is saved when the window is closed. 
 

Result Measures 

The table of summary results includes a large number of 
summary measures; these are defined in the list below. 
 
Channel: Left or Right limb 
Day: Day number in the recording 
Device Type: MW8, the recording device used 
Serial No.: The serial number of the recording device, in 
case any fault must be traced 
Start Date: Of the selected night 
Start Time: Of the selected night 
End Date: Of the selected night data 
End Time: Of the selected night data 
Duration: Of the selected night 
Total Samples: Number of 1-second epochs in the night 
period 
Total Positive Samples: Number of epochs with activity 
data ≥1 
Total Zero Samples: Number of epochs with zero activity 
Total Missing Samples: Number of epochs marked as 
missing data in recording 
Total PLM Bouts: The number of contiguous periods 
classified as PLM during the night 
Highest PLM Bout Duration: The length, in hours, 
minutes and seconds, of the longest continuous PLM bout 
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Lowest PLM Bout Duration: The length, in hours, 
minutes and seconds of the shortest PLM bout 
Average PLM Bout Duration: The total of all PLM bout 
lengths divided by the number; again in hours, minutes 
and seconds 
First PLM Bout Occurrence: Date and time of the start of 
the first PLM bout 
Last PLM Bout Occurrence: Date and time of the start of 
the last PLMS bout 
Total Movements (overall): The number of isolated 
periods of activity, subject to the current setting for 
combining kicks with a short gap 
∟ (within PLM bouts): The number of isolated 
movements which occurred within time classified as a PLM 
bout 
∟ (outside PLM bouts):  The number of isolated 
movements which occurred outside time classified as a 
PLM bout 
PLM Index (PLMI):  The number of movements within 
PLM divided by the length of the night period in hours 
Ave Movements Per Hour (overall):  Total movement 
count divided by the length of the night period in hours 
∟ (within PLM bouts):  Total movements within PLM 
divided by the length of the night period 
∟ (outside PLM bouts): Total movements outside PLM 
divided by the length of the night period 
Total Movement Duration (overall):  Total time of all 
isolated movements, in hours, minutes and seconds 
∟ (within PLM bouts): Total time of isolated movements, 
within periods classified as PLM bouts 
∟ (outside PLM bouts): Total time of isolated 
movements, outside periods classified as PLM bouts 
Ave Movement Duration (overall):  Average length of all 
movements (PLM or non-PLM), in seconds 
∟ (within PLM bouts): Average length of all movements 
within time classified as PLM, in seconds 
∟ (outside PLM bouts): Average length of all movements 
not within time classified as PLM, in seconds 

 
Copy All Results to Clipboard 

Clicking this button will copy the results for all days in all 
channels to the clipboard. These can then be pasted into 
an external application such as a word processor.  
 

Save All Results to File 

Clicking this button will allow you to save the results for all 
days across all channels to a text file for external use or 
storage. 
 

Print Results 

Clicking this button will open the report preview for the 
analysis which can be used to preview and print a physical 
copy of the analysis (detailed in the next section). 
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7.2 Viewing 
Periodicity  

The periodicity window allows you to compare the duration 
and frequency of periodic leg movements in a recording. 
This window can be opened by clicking the ‘Tools’ menu, 
followed by the ‘Periodicity’ menu item. 
 

 
 
The green elements represent the duration in seconds of 
PLMs and the yellow elements show the duration of PLMs 
laterally. A graph is shown for each day in each channel. 
 
There are two ordering modes: Day and Channel. The 
Day mode displays each channel in order of date. The 
Channel mode will display each day within each channel 
in channel order. The display order can be changed by 
clicking the ‘Order by:’ drop down and the clicking either 
the Day or Channel options. 
 
The height of the graphs can be changed by dragging the 
‘Graph Height:’ slider left or right. The amount of vertical 
seconds to display can be changed by dragging the 
‘Maximum Seconds:’ slider left or right. 
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The periodicity settings can be reset by clicking the ‘Reset’ 
button. 
 

 

7.3 Printing the 
Analysis 

The application provides printing functions to produce 
physical copies of the analysis graphs and results. The 
analysis can be previewed and customised prior to being 
sent to the printer.   
 
To preview a printed report, ensure at least one channel is 
set up and click the 'File' menu, then click the 'Print' menu 
item. The report preview window will then be displayed as 
shown below:  
 

 
 

Reports can be browsed by clicking the 'Prev Page' and 
'Next Page' buttons located on the top toolbar. This will 
move to the previous or next pages in the report. The 
current page number is shown in the bottom status strip. 
 

        
 

The preview can be zoomed to provide better readability of 
the report contents. This can be done by clicking the 
'Zoom In' and 'Zoom Out' buttons located on the top 
toolbar. The current zoom level is also shown in the bottom 
status strip. 
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To customise which results/statistics are shown on the 
printed report, click on the 'Choose Stats' button located 
on the top toolbar to open the ‘Select Statistics’ dialog. 
Options which are checked will be shown on the report, 
whereas options which are unchecked will be absent from 
the report. Click on an option to enable or disable it and 
then click the 'Update' button at the bottom of the window. 
This will cause the report to be recreated.  
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To change the page size for the report, click on the 'Page 
Setup' button located on the top toolbar. Paper size can 
be changed by clicking on the 'Size' drop down menu and 
selecting a new size. Printing orientation can be changed 
by clicking the 'Portrait' or 'Landscape' options. Click on 
the 'OK' button to save the changes.  
 

 

 

 

To print the report, click on the 'Print' button located on the 
top toolbar. To select a printer, click on one of the printer 
entries in the 'Select Printer' box. To customise which 
pages are printed, click on the 'Current Page' option, or 
enter specific page numbers into the 'Pages' text box. The 
number of copies to print can be set by entering a number 
in the 'Number of Copies' box. Click on the 'Print' button 
to send the report to the printer.  
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7.4 Saving the 
Analysis 

After one or more recordings have been analysed, the 
analysis can be saved to a single file for later use. This 
allows the recordings to be quickly restored without having 
to set them up again. Manual PLM adjustments and user 
notes and remarks are also saved. 
 
To save, click on the ‘File’ menu and then click on the 
‘Save Analysis’ menu item. The application will prompt 
you to save a file with the extension ‘.pax’ which captures 
all of the details above. 
 
To reload a saved analysis file, click on the ‘File’ menu, 
followed by the ‘Open Analysis File’ menu item. Note that 
all loaded recordings and analysis results will be discarded 
to reload a previous analysis.  

 

7.5 Exporting 
Results Data 

 
Raw Classification Results 

The detailed epoch-by-epoch analysis results can be 
exported from the software through the ‘File’ menu 
followed by then ‘Export’ menu item. The ‘Export Data’ 
window below will be produced:  
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Firstly, select the intended output format. Both options 
create a plain text format file, but with slightly different 
formatting: 
 

 Plain Text Document creates a text format file 
which can be opened and viewed directly in a text 
editor. The output is spaced such that the table 
content will appear correctly. 

 Comma Separated Spreadsheet creates a text 
format file which can be opened directly by most 
spreadsheet programs, such as Excel. The values 
will be placed into the cells of the spreadsheet. 

 
 
Summary Result Measures 

In addition to the raw classification data above, the 
summary statistics can also be exported from the results 
table described previously. To do so, re-open the results 
window as shown below, and select one of the export 
options highlighted. 
 

 
 

After clicking on ‘Copy All Results to Clipboard’, you 
should open a spreadsheet program and use the paste 
function to place the result measures there. Note that you 
may need to scroll down to see the table of results from 
each night of the recording. 
 
The ‘Save All Results to File’ option exports in the same 
format but directly to a text file, allowing it to be opened in 
a text editor or directly processed by scripts as needed. 

1 

2 

3 
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Appendix A - Maintenance and Utilities 
 

A1 - The Utilities 
Tab 

The MotionWatch manager has an additional tab called 
‘Utilities’, click on this tab to display a window similar to 
the following: 
 

 
 

This screen shows some technical information about the 
MotionWatch: 
 

 Bootloader Ver: This is the version number of part 
of the embedded operating software that allows the 
MW8 to be updated remotely. 

 Firmware Ver: This is the version number of the 
main operating software for the MW8. 

 Serial Number: The watch serial number 

 Battery voltage: Typically this will show a value 
above 3.0V for a new battery and will decline 
gradually over the usage period. 

 Reset Count: Used as debug information – the 
number of unexpected reset events. 

 Run Time: hours of run time since last battery 
change – should reset to zero when a new battery 
is fitted. 

 Battery Fitted: the date that the watch battery was 
fitted. 
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A2 - Firmware 
Update 

The MotionWatch has the ability to be re-programmed 
when new features become available. It is always 
recommended that the most up-to-date firmware and PC 
software are used to avoid possible conflicts and data loss. 
To check for an update, select the ‘Utilities’ tab then click 
on the ‘Check for Update’ button. The software will 
provide a confirmation if an update is available for the 
MotionWatch. 
 
To update the firmware, ensure that the MotionWatch is 
connected and then click on the ‘Update Firmware’ 
Button. Take note of the warning message and click OK if 
you wish to proceed. 
 
IMPORTANT: All data and settings will be destroyed by 
the firmware update process. Please ensure that any data 
has been downloaded before commencing. 
 
WARNING! Do not interrupt the firmware update process – 
doing so may damage the MotionWatch which will then 
require factory re-programming. 
A progress bar will indicate the update progress (this will 
take a few seconds). 
The MotionWatch will then automatically disconnect, apply 
the firmware, then re-connect. The MotionWatch Manager 
window will be temporarily closed during this period and 
will automatically re-load and show a verification message 
upon completion. 
 
Depending upon the type of update, it may be necessary 
to manually re-set the MotionWatch. If the MotionWatch 
Manager does not re-load automatically, disconnect the 
Watch, remove the battery for at least 1 minute, re-fit and 
re-connect the USB. The verification message should then 
be shown. 
 

A3 - Shutdown 
Options 

The MotionWatch has a low power shutdown function 
which will help maximise the life of the battery. In the 
utilities windows, there are two options as follows: 
 

 Auto Shutdown After Download: this option 
allows the MotionWatch to shutdown automatically 
following download. Data in the watch will NOT be 
lost but the watch will stop recording. When not 
selected, the MotionWatch will continue to record 
until its memory is full and then shutdown. 

 Shutdown Watch: Allows the watch to be 
shutdown manually. Click this button to ensure the 
watch will be shut down when disconnected from 
the USB cable. 
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A4 - Changing the 
Battery 

The MotionWatch has been designed to facilitate quick 
and simple battery changing. 
 

 The change the battery, open the MW8 casing as 
described in Section 1.1 An Overview of the 
MotionWatch for PLMS System to expose the USB 
connection and battery.  

 Do not connect the USB cable! 

 Using a suitable tool, carefully push the battery out 
from the holder towards the USB connector. 

 
 
 
 
 
 
 
 
 
 
 
 

 Grasp the battery and withdraw it completely from 
the holder. 

 Wait at least 1 minute then place a fresh CR2032 
battery into the holder (ensuring correct 
orientation!) and push back until fully home. 

 
 

 
 
 
 
 
 
 
 
Note: Data will NOT be lost by removal of the battery. 
 
Observe the LED on the front of the MotionWatch, the 
correct start sequence is indicated as follows: 

 LED stays on for 4 seconds. 

 LED goes off for 8 to 12 seconds. 

 LED flashes once. 
This sequence is critical to the correct watch operation – if 
the LED does not flash, remove the battery and repeat the 
process. 
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The MotionWare software will automatically detect that a 
new battery has been fitted. If the watch contains data that 
has not been downloaded the following message will be 
displayed: 
 

 
 
Click ‘OK’ and then download the data from the watch. 
 
To complete the battery replacement process a 
confirmation message will be displayed. 
 

 
 
 
Select ‘Yes’ and the software should display 100% in the 
battery life indication. If the new battery is not detected 
remove the battery and repeat the steps above taking time 
to observe each step. If the battery is not replaced 
correctly the watch may stop prematurely with no warning 
and the battery life indicator will be incorrect. 
 
 

A5 - Waterproof Seal 
The MotionWatch relies upon a rubber O-ring seal around 
the top face of the lower part of the casing. The seal 
should be periodically checked to ensure that it is correctly 
seated, clean and not damaged. (note that some silicone 
grease residue will be apparent – do not remove this). 
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A6 - MotionWatch 
Strap 

The PLMS foot mounting strap is supplied with a spare 
lower watch casing to facilitate use of the MotionWatch 
without the need to remove the wrist strap. Note that the 
MotionWatch will not be waterproof when fitted the the 
PLMS strap. 
 
The MotionWatch is supplied as standard with an extra-
long moulded silicone watch strap. The strap is fitted with 
two standard 12-14mm watch spring bars. These bars are 
spring loaded to allow fitting and removal from the watch 
casing (see photo). 
 
 
 
 
 
 
 
 
 
To remove the Strap: Use a flat bladed tool to gently 
depress one end of the spring bar by levering against the 
side of the casing. Take care not to damage the 
MotionWatch casing. 
 
To Fit a Strap: Push the spring bar into the hole through 
the strap then place one end of the spring bar into one 
hole in the watch casing. Gently depress the exposed end 
of the spring bar and then slide into the hole in the casing; 
a positive ‘click’ will be heard. 
 
 
 
 
 
 
 
 
 
 
 
Replacement straps and alternative straps are available 
from CamNtech. 
 
It is possible to use any standard watch strap with a 12 to 
14mm shoulder with the MotionWatch. 
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Appendix B – FAQ & Troubleshooting 
 
What limits the memory size? 

Availability of the correct type of memory chips is the main 
limitation. The technology used is reliable, low power and does 
not require protracted erase cycles. The MotionWatch uses the 
maximum amount of this type of memory that will physically fit 
within the device. 
 

Will I lose my data if I fit a new 
battery? 

The MotionWatch uses non-volatile memory so any data stored 
will not be lost if the battery is removed or replaced. Note that 
the MotionWatch will automatically shut down when the battery 
voltage is low to prevent erroneous data. 
 

The MotionWatch is not 
recognised or will not 
communicate: 

Ensure that the battery has sufficient charge. If the battery has 
run down, the watch will not be recognised when attached to the 
USB port. Disconnect from the USB and remove then 
refit/replace the battery (see maintenance section for details of 
battery changing). Wait at least 1 minute before re-fitting the 
battery. 
 
Some types of Micro USB cable will not make a positive 
connection – please use the cable supplied. 
 
Occasionally the cable connector may become damaged or worn 
– try a new USB cable. 
 

The software offers to update 
the MotionWatch firmware – 
what does this mean? 

The MotionWatch Software is shipped with the latest device 
operating firmware. If the software detects that any MotionWatch 
has older firmware, it will inform you that an update is available. 
It is recommended that firmware updates are applied to ensure 
that you benefit any improvements to the device (see 
maintenance section for details of battery changing). 
 

What are the potential effects 
of Electromagnetic 
interference? 

The MotionWatch system was designed to minimise the effects 
of external EMI upon the device and to minimise the effect upon 
the environment from the device. The system conforms to the 
appropriate standards with respect to EMI performance (see 

Appendix C5 - EMC Declaration and Guidance). In cases 
where strong EMI does affect the MotionWatch, the device will 
recover with no user intervention. 
 

Can I change the Watch Strap? 
Yes – see Appendix A6 - MotionWatch Strap above.  
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I see ‘Device setup re-write’ 
message when I apply a new 
set-up 

The MotionWare software will read back the watch set-up and 
verify that it is correct. If the verification fails, the following 
message will be displayed: 
 

  
This indicates that the software is re-trying to write the setup to 
the watch. In most cases the re-try will solve the problem and the 
message will change to the normal setup confirmation message. 
If the setup problem persists then the software will display the 
following warning: 
 

 
 
In this case, click ‘OK’ then disconnect the MotionWatch from the 
USB. Re-run the software, re-connect the watch and re-apply the 
set-up. 
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Appendix C – Safety & Environmental Information 
 

C1 - Decontamination 
 All used devices must be considered to be 

contaminated with surface borne bacteria and must 
hence be de-contaminated before re-use using a 
suitable disinfection and cleaning procedure.  

 Care must be taken to use the correct de-
contamination procedure and cleaning materials 
because long term exposure to certain cleaning 
materials is known to attack plastics which can lead 
to premature failure of the mechanical integrity of 
the medical device casing. 

 The MotionWatch casing relies upon maintaining 
the lubrication of the seals and mating surfaces to 
ensure water resistance and to aid opening/closing 
of the casing. 

 CamNtech recommend the use of aqua based 
disinfection products and our recommended 
products are Clinell® Universal Wipes or Spray. 
These products do not contain chemicals known to 
cause deterioration of plastics. 

 Do not use products containing Glutaraldehyde, 
Glucoprotamin, Isopropyl, ethyl, or methyl alcohols, 
hydrogen peroxide, or bleach products. Do not use 
plasma sterilization or ethylene oxide sterilization 
procedures, Do not autoclave. 

 Do not apply self-adhesive labels or tapes to the 
casing. 

 Begin by spraying and/or wiping all visible 
surfaces of the closed MotionWatch body and 
strap with the cleaning agent. Ensure that all 
surfaces are dried before proceeding. Open the 
casing to clean only the areas outside of the 
waterproof seal (see diagrams below). NOTE - it is 
essential not to allow cleaning solutions to enter the 
electronics!  

 Important! – do not clean the O-ring seal as this 
removes the lubricant which can make the casing 
difficult to open and may reduce the water 
resistance. There is no requirement to clean inside 
the waterproof area of the casing (see diagrams 
below). 
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Cleaning the lower casing (strap not shown) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Cleaning the upper casing 
 

 
 
 

  

Clean only OUTSIDE of the 
red bounded area – do NOT 
remove the lubrication from 
the O-ring seal. 

Clean only OUTSIDE of the 
red bounded area – do not 
clean the vertical side walls 
and ensure no cleaning agent 
enters the electronics. 
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C2 - Battery 
 The device is battery operated and operates at voltages 

below 5V DC; there is hence no risk from electric shock. 

 The battery is user replaceable (see Appendix A4 for 
further information). 

 The battery must be replaced observing the correct 
procedure to prevent possible data loss (see Appendix 
A4 for further information). 

 The battery is a standard Coin Cell type CR2032. 
Always ensure that the battery used conforms to the 
safety standard EN60086-4:2007. 

 Battery is a swallowing hazard for small children – 
do not leave small children unattended when the 
device casing is open. Take care when handling and 
disposing of coin cell battery. 
 

C3 - Warnings – 
General 

 The MotionWatch is NOT defibrillation proof. 
 

 

C4 - Disposal at End 
of Life 

Waste Electrical & Electronic Equipment (WEEE) The EU 
requires, under the Waste Electrical and Electronic 
Equipment Directive 2012/19/EU that manufacturers 
and/or distributors of Electronic and/or Electrical 
Equipment manage and pay for the collection and further 
handling of WEEE products, as well as provide WEEE-
related information to their customers. CamNtech has 
taken the following approach to complying with this 
Directive: 

 CamNtech has registered with an approved producer 
compliance scheme (PCS) in accordance with the 
requirements of the WEEE Directive. 

 CamNtech will provide free recycling for all of its WEEE 
products when returned to CamNtech. 

 CamNtech WEEE products will be designed with 
recycling, reuse and waste management as a 
consideration. 

 CamNtech WEEE products will be labelled or stamped 
with the WEEE marking in accordance with European 
Standard EN 50419 
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C5 - EMC 
Declaration and 
Guidance 

The following tables provide a declaration of compliance 
and user guidance regarding Electromagnetic (EM) 
compatibility of the MotionWatch devices. 

Electromagnetic Emissions 
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Essential Performance 

Adjacent Equipment 

Connecting Cables 

Use adjacent to Portable RF Communications equipment 
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Electromagnetic Immunity 
 

IEC61000-

4-3 

 

 

IEC61000-

4-3

10 V/m 80-

2700 MHz 

1 kHz 80% am 

9-28 V/m 385-

6000 MH   

pulse mode  
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Appendix D – Technical Specifications 

Specifications 

Functional Specifications 

Size mm:  36(l) x 28.2(w) x 9.4(d) excluding strap 

Weight:  9.1 grams (including battery, excluding strap) 

Sensor: Tri-axial, MEMs technology. 0.01g to 8g range, 3 – 11Hz 

Battery: CR2032 Lithium Coin Cell 

Battery Life: 4 Months run time; simple user change 

Memory: 4Mbits non-volatile (120 days recording @ 1min epoch - 
uncompressed) 

Waterproof: IPX7 -  up to 1 hour at 1m (suitable for swimming) 

Marker button: Yes – with visual feedback 

Epoch: 1, 2, 5, 15, 30, 60 seconds 

Comms: Direct USB, Plug & Play drivers, Micro USB cable. 

Download: All data in 50 seconds approx. 

Strap: Bespoke XL 12mm silicone  (245mm overall length) or 12mm 
nylon 

Light Sensor  

Type: Digital – human eye response optimized. 

Range: Automatic ranging; 0 to 64000lux 

Resolution: 0.25lux (0-1000 lux range) 

1.00lux (1000-4000 lux range) 

4.00lux (4000-16000 lux range) 

16.0lux (16000 – 64000 lux range) 

Sampling: 1 sample per second – averaged over epoch 

 

Operating & Storage Conditions 

Complies with the requirements of EN60601-1-11:2010 

 Operating Storage 

Temperature +5°C to + 40°C -25°C to +70°C 

Relative Humidity 0 to 93% 0 to 93% 

Atmospheric Pressure 70kPa to 106kPa 70kPa to 106kPa 
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Accelerometer Processing 

Raw acceleration measurements are processed by the on-board software of the 
MotionWatch to produce a quantitative measure of the activity during each epoch.  
This is a four stage process which is applied to the accelerometer data:   
 

1. The channel perpendicular to the watch is separated and subjected to the 
bandwidth filtering specified above (3-11Hz). 

2. The peak acceleration (either positive or negative) during each second is 
recorded. 

3. This is compared to a minimum “not moving” threshold. Values below this 
threshold are ignored to simplify the final activity graph. 

4. The result from each second is summed over the epoch and scaled to 
produce a standard result in controlled jig testing. This value is then recorded 
as the MotionWatch count for the epoch. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This process is illustrated in the diagram below, showing the acceleration waveform 
over two epochs, each containing two seconds of data. 
 

 

+35 +40 -25 -30 

one second 

First 2 second epoch 
35 + 40 = 75 

Second 2 second epoch 
25 + 30 = 55 

75 MW counts 55 MW counts 

Sensitive in this 
direction 
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To 
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0.0 0.9 28/04/14 First draft DW 

0.9 1.0 10/11/14 Updated ready for release TE 

1.0 1.0.1 21/11/14 Updated screenshots, additional context DW 

1.0.1 1.0.2 05/06/15 Updated references of ICSD to version 3 (2014) 

Added body mounting context 

DW 

1.0.2 1.0.3 29/06/15 Added updated settings screenshots and context for ICSDv2/AASM 2.1 
configurations 

DW 

1.0.3 1.0.4 11/07/16 Added main window overview page DW 

1.0.4 1.0.5 12/07/16 Updated document with screenshots from a recent build. DW 

1.0.5 1.0.21 03/04/17 New settings layout. Changed version to match software version. DW 

1.0.21 1.0.22 19/06/17 Added periodicity information. DW 

1.0.22 1.0.23 31/12/19 Updated  Device Manager screen shots, updated for MDR, new 
CamNtech address, EMC guidance, software installation, Win 7 
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